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Introduction

Desktop and mobile Architecture for System Hardware or DASH defines a set of
interoperability standards for managing, monitoring and controlling PCs regardless
of system power state (on, off, stand-by) or operating system capability. DASH
builds upon previous standards-based management technologies for PC clients and
datacenter servers in order to provide robust management capability previously
unattainable. This paper describes the DASH capabilities available on HP business
class desktops and workstations equipped with the Broadcom NetXtreme™ Gigabit
Ethernet Plus network controller with Broadcom TruManage™ technology.

DASH Overview

In July 2008, the Distributed Management Task Force introduced the Desktop and
mobile Architecture for Systems Hardware (DASH) specifications. Development of
the DASH specification is an ongoing collaborative effort between computer system
manufacturers, component and peripheral suppliers, and management software
vendors. HP has played an important role in fostering the DASH ecosystem with
our partners and suppliers and promoting both DASH capable PCs and
management software that utilizes the DASH standard.

DASH is an industry standard that allows you to perform essential management
tasks on PCs, regardless of their power state or operating system state. Achieve
smarter, more efficient control of your business with DASH capable HP business
class desktops and workstations.

The DASH standards are designed to assist in the remote management of common
desktop infrastructure tasks, such as deploying new operating systems, monitoring
of computer system health, power control and power state monitoring, and asset
inventory collection. As new hardware technologies are introduced or additional
requirements are placed on the IT infrastructure, DASH will continue to evolve to
include new functionality.



Development of the DASH specifications is based on a history of preceding
technologies and specifications. DASH has been designed to solve many of the
pitfalls and constraints of previous management standards by leveraging well-
proven technologies from the Service Oriented Architecture domain, advancements
in security standards, and extensive modeling of management components,
configuration data and relationships first introduced in the server management
domain.

Alert Standard Format (ASF) was the previous industry-wide remote management
standard. Unlike ASF, DASH is a web services-based management protocol and
relies on security and network routing concepts familiar to web site and web
services administrators. DASH consists of a richer set of features than ASF, with a
broader set of vendor support than ASF had at launch time. DASH supports feature
extensions (described as management profiles) in a standard manner which ensures
multiple versions of the DASH standard can be deployed within an enterprise
environment with support from a single console infrastructure.

o Service availability without the requirement of an installed operating system

o Interoperability between various DASH-capable device implementations and
management consoles

o Descriptive data model allowing for the discovery of iterative specification
updates (new profiles) or vendor-specific extensions (custom profiles)

e Well understood transport level security (HTTPS basic and digest authentication
models with optional TLS client/server certificate support)

e Support for multiple users and multiple access roles (administrator, operator,
auditor)

o DASH ecosystem can coexist with legacy ASF infrastructure

A management profile is a specification that defines a normative set of behaviors
and characteristics for addressing a particular management domain.

A profile consists of the following information:

— A data model representing the problem domain that consists of objects,
properties and methods exposed by the profile

— Use cases to be addressed by the profile
— Steps required to traverse the data model and derive results

— Required and optional components of the profile

DASH profile and specification requirements

Functionality DASH 1.0 DASH 1.1
Base Desktop and Mobile Profile 1.0.0 Required Required
WS-Management Specification 1.0.0 Required Required




Functionality DASH 1.0 DASH 1.1

WS-Management - CIM Binding Specification 1.0.0 Required Required
WS-CIM Mapping Specification 1.0.0 Required Required
Profile Registration Profile 1.0.0 Required Required
Role Based Authorization Profile 1.0.0 Required Required
Simple Identity Management Profile 1.0.0 Required Required
Boot Control Profile 1.0.0 Optional Optional
CPU Profile 1.0.0 Optional Optional
Fan Profile 1.0.0 Optional Optional
Indications Profile 1.0.0 Optional Optional
Physical Asset Profile 1.0.0 Optional Optional
Power State Management Profile 1.0.0 Optional Optional
Power Supply Profile 1.0.0 Optional Optional
Sensors Profile 1.0.0 Optional Optional
Software Inventory Profile 1.0.0 Optional Optional
System Memory Profile 1.0.0 Optional Optional
Battery Profile 1.0.0 Optional
BIOS Management Profile 1.0.0 Optional
DHCP Client Profile 1.0.0 Optional
DNS Client Profile 1.0.0 Optional
Ethernet Port Profile 1.0.0 Optional
Host LAN Network Port Profile 1.0.0 Optional
IP Interface Profile 1.0.0 Optional
KVM Redirection Profile 1.0.0 Optional
Media Redirection Profile 1.0.0 Optional
Opaque Management Data Profile 1.0.0 Optional
OS Status Profile 1.0.0 Optional
Software Update Profile 1.0.0 Optional
Text Console Redirection Profile 1.0.0 Optional
USB Redirection Profile 1.0.0 Optional

When a substantive block of new profiles become available, or fundamental
changes are introduced to the DASH ecosystem, the DASH Implementation
Requirements document is updated to reflect a new version of the standard. Profiles
are continually being developed by the DMTF and DASH is designed to support
them as they become available.

New to DASH?

Visit the DMTF Learning Center at:
http://www.dmtf.org/education/



http://www.dmtf.org/education/

HP and Broadcom have provided multiple software releases of the DASH
components to assist in enabling the community. We are committed to the
continued development of new manageability enablement functionality as profiles
mature within the DMTF.

Software and firmware updates are routinely released and can be downloaded
from www.hp.com/#support. Softpags that are released for a specific operating
system only contain device driver and software updates. These softpags support
SSM and can silently update all the software components (device driver, Broadcom
Advance Control Suite, management agent, and CIM provider) needed to enable
DASH on the system. For other advance tools that can be used in enabling DASH
or troubleshooting, such as BMCC, download the Broadcom NetXtreme Gigabit
Drivers for Multiple Operating Systems softpaq. Firmware updates can also be
downloaded from the Support website. Follow instruction in the Upgrading System
Software section to update firmware and software.

Broadcom's TruManage™ technology is built on the scalable NetXtreme™ Gigabit
Ethernet controller architecture that combines highly optimized hardware, firmware
and software to enable reliable, secure and energy efficient management
functionality for in-band, out-of-band and out-ofservice environment. Gigabit
Ethernet controllers with TruManage™ technology integrate an on-chip application
processor and memory to provide a single-chip solution for network connectivity
and platform manageability at all times.

The following table outlines DASH profile level support that is available with the
Broadcom NetXtreme™ Gigabit Ethernet Plus controller on HP platforms.

DASH profile availability on HP platforms

TruManage™ Version

Functionality 1.0 1.1 1.2
Base Desktop and Mobile Profile 1.0.0 1.0.0 1.0.0
WS-Management Specification 1.0.0 1.0.0 1.0.0
WS-Management - CIM Binding Specification 1.0.0 1.0.0 1.0.0
WS-CIM Mapping Specification 1.0.0 1.0.0 1.0
Profile Registration Profile 1.0.0 1.0.0 1.0.0
Role Based Authorization Profile 1.0.0 1.0.0 1.0.0
Simple Identity Management Profile 1.0.0 1.0.0 1.0.0
Boot Control Profile 1.0.0 1.0.0 1.0.0
CPU Profile 1.0.0 1.0.0 1.0.0
Fan Profile 1.0.0 1.0 1.0
Indications Profile 1.0.0 1.0.0 1.0.0
Physical Asset Profile 1.0.0 1.0.1 1.0.2
Power State Management Profile 1.0.0 1.0.1 1.0
2.0.0 2.0.0
Power Supply Profile ™ 1.0.0 1.0.1 1.0.1
1.1.0 1.1.0
Sensors Profile 1.0.0 1.0.1 1.0
Software Inventory Profile % 1.0.0 1.0.0 1.0.0



http://www.hp.com/#support

TruManage™ Version

Functionality 1.0 11 1.2
System Memory Profile 1.0.0 1.0.0 1.0.0
Battery Profile

BIOS Management Profile ™ 1.0.0 1.0.0 1.0.0

DHCP Client Profile

DNS Client Profile

Ethernet Port Profile 1.0.0 1.0.0 1.0.0

Host LAN Network Port Profile

IP Interface Profile

KVM Redirection Profile

Media Redirection Profile

Opaque Management Data Profile 1.0.0 1.0.0 1.0.0
OS Status Profile 1.0.0 1.0.0 1.0.0
Record Log ¥ 1.0.1
Software Update Profile ) 1.0.0 1.0.0
Text Console Redirection Profile 1.0.0 1.0.1 1.0.1
USB Redirection Profile 1.0.0 1.0.0

" Feature is not implemented on HP products.

@ Feature supports limited set of software inventory available absent of an
operating system.

) The Record Log profile was published after the DASH 1.1 update.

“) Feature supports out-of-band software update of management firmware.

More on DASH Profiles

DASH profile specification source material can be found
at: http://www.dmtf.org/standards/profiles/

Additional functionality beyond the capabilities defined in the DASH specification is
also available to enable the DASH ecosystem and promote usability extensions.

The following table details additional capabilities that are available on HP
platforms equipped with the Broadcom NetXtreme™ Gigabit Plus controller.

Manageability extensions available on HP platforms

TruManage™ Version

Feature 1.0 1.1 1.2
Certificate authority integration . .
Embedded management console . . .
Event logs with auditing support .
Graceful power control for Microsoft® Windows® . .
In-band NIC management support . . .
Kerberos authentication support .
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TruManage™ Version

Feature 1.0 1.1 1.2
Microsoft® Active Directory integration .
Out-of-band IPv6 phase | certification . . .
Out-of-band IPv6 phase Il certification . .
Out-of-band firmware update . .
WMI provider for Ethernet port modeling ) . .
WMI provider for opaque management data .
WMI provider for software inventory . . .
WMI provider for user account management . .
WMI provider for VLAN teaming extension . .
Zero-Touch Provisioning Model . .

Enabling DASH Support

HP does not typically ship platforms in a predefined management mode, unless the
products are ordered through a custom configuration service where the customer
can specify various parameters supporting their infrastructure and deployment
model. In order to enable DASH support on HP platforms the following steps must
be performed:

1. Ensure you have the latest system BIOS and software drivers for your platforms.
2. Set a BIOS administrator password to authorize access to configuration option.

3. Select and enable the appropriate management controller within the system

BIOS.

4. Select the appropriate management mode for the controller (in this case DASH)
within the system BIOS.

5. Enable management functions from the network device
6. Add user accounts to access the management interface on the network device.

The following sections discuss the steps to enable DASH functionality from a remote
management standpoint without requiring physical access to the system; however it
is possible to setup and configure DASH support manually. For instructions on how
to complete this process using where you have local physical access to the system
to be configured, please refer to Appendix B: Enabling Management Functionality
with Computer Setup and Appendix C: Enabling Management Functionality with
BMCC and BACS later in this document.

The Broadcom NetXtreme™ Gigabit Ethernet Plus is the default network controller
option for the following platforms:

e HP Compaqg 6005 Pro Business PC

Although the Broadcom NetXtreme™ Gigabit Ethernet Plus discrete PCI Express
add-in card is available as an option for HP business class desktops and
workstations, DASH functionality is only supported on the models defined below:



e HP Compaq 8000 Elite Business PC
e HP Compaqg 6000 Pro Business PC
e HP Compaq dc7900 Business PC

e HP Compaq dc5850 Business PC

e HP Z800 Workstation

e HP Z600 Workstation

e HP Z400 Workstation

System BIOS

To ensure the best operating experience for your product and accessibility to all of
the available DASH features, HP recommends that you update your system firmware
as part of a DASH deployment strategy. The following table outlines minimum
BIOS version requirements to enable DASH support for your platform.

BIOS version requirements by platform

Hardware Platform BIOS Family Version
HP Compag 8000 Elite Business PC 786H1 1.00
HP Compaq 6005 Pro Business PC 786G6 1.03
HP Compag 6000 Pro Business PC 786G2 1.09
HP Compag dc7900 Business PC 786G1 1.08
HP Compag dc5850 Business PC 786F6 2.06
HP Compag dc5800 Business PC 786F2 1.53
HP Z800 Workstation 786G5 114

HP Z600 Workstation 786G4 114

HP Z400 Workstation 786G3 114

M The HP Compaq dc5800 Business PC does not support DASH functionality.
However, the Broadcom NetXtreme™ Gigabit Ethernet Plus controller will perform
as an ASF management device in the platform. A BIOS update may be required to
enable this support.

Software Drivers

The Broadcom NetXtreme™ Gigabit Ethernet Plus has driver support for Windows®
XP and Windows Vista®.

o For Windows® XP, use driver version 10.85.0.0 or newer.

e For Windows Vista®, use driver version 10.100.0.0 or newer.

Deploying Software Updates

Software updates (including system BIOS) can be downloaded and deployed
through HP Client Automation or HP Client Manager directly. If you are using
another management console solution, HP provides software patch management
support which can be delivered through your management consoles’ task engine
using HP System Software Manager.



HP System Software Manager

Information on how to use HP System Software Manager
to deploy software updates can be found at:
th: www.hp.com qo/ssm

In order to use DASH as our management protocol, we need to ensure that the
system BIOS is prepared to communicate system management and health data with
the Broadcom NetXtreme™ Gigabit Ethernet Plus controller.

HP provides a mechanism to remotely instrument and configure system BIOS
settings called the HP Client Management Interface. This interface provides an
easily scriptable environment for updating BIOS settings within your environment.

HP Client Management Interface

Information on how to use the HP Client Management
Interface to configure BIOS settings can be found at:
http://www.hp.com/go/hpcmi

The management tasks we will perform to prepare that platform for DASH
management will be demonstrated using HP Client Management Interface samples
which are included in the HP Client Management Interface Administrator Toolkit.
The administrator toolkit can be used as is, or you can use it as a basis for creating
your own custom script implementations.

All of these examples require access to WMI, they can be performed locally on a
computer system, but the scripts are designed to run remotely as well. The
examples will be from the point-of-view of an Administrator executing a task
targeted at a remote PC named “remotePC”. All of the scripts are designed to take
a series of remote targets either as machine names or IP addresses separated by
spaces.

Setting the BIOS Administrator Password

It is good practice and a requirement for management of some BIOS features to set
the BIOS Administrator password. This password is separate from the user
management associated with DASH.

Using Windows® Scripting Host, execute the following line from a Command
Prompt:

cscript ChangeSetupPassword.wsf remotePC

You will be prompted to enter the current BIOS Administrator password and a new
one.

Setting the Primary Management Controller

For systems where there are more than one network controller present, as is the
case when adding the Broadcom NetXtreme™ Gigabit Ethernet Plus card to a
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system, we must inform the system BIOS which device will act as the primary
management controller. Only one network controller can act as the management
interface for the platform. This allows the system BIOS to communicate system
information and health status directly with the device.

Using Windows® Scripting Host, execute the following line from a Command
Prompt:

cscript ChangeSetting.wsf /setting:"Broadcom Ethernet
controller" /value:"Primary" remotePC

You will be prompted to enter the current BIOS Administrator password.

Setting the Management Mode

Once we have informed the system BIOS which management controller we wish to
use, we can now select a management mode for the controller to operate in.

Using Windows® Scripting Host execute the following line from a Command
Prompt:

cscript ChangeSetting.wsf /setting:"Management Mode"
/value:"DASH" remotePC

Again, you will be prompted to enter the current BIOS Administrator password.

This section outlines the steps required to configure and enable DASH management
from the Broadcom NetXtreme™ Gigabit Ethernet controller.

Broadcom provides a general-purpose tool for setting and configuring the
Broadcom NetXtreme™ Gigabit Ethernet controller through Windows Management
Instrumentation (WMI) as part of the TruManage™ 12.4 software package.

All of these examples require access to WMI. They can be performed locally on a
computer system, but the scripts are designed to run remotely as well. The
examples will be from the point-of-view of an Administrator executing a task
targeted at a remote PC named “remotePC"” specified using the syntax:

-remote:RemotePC from the command line. In addition the Broadcom script
supports specification of the WMI connection user account with the following
syntax: -user:<UserID> -password:<Password>.

Enabling the Administrator account

The following command will enable the default administrator account on the DASH
management device and use the password specified via the command line. Once
the administrator account is enabled, you can use any DASH management console
to manage user accounts and roles.

10



WMIconfig.jse -remote:remotePC -user:Administrator
-password:<password> account "?Name='Administrator'"
.password=NewPassword .enabledstate=2

Using Active Directory

The DASH management device may be configured to use a Microsoft Active
Directory infrastructure for authentication purposes. This alleviates the burden of
managing passwords on each individual DASH device directly. To setup third-party
authentication using Active Directory we need to enable support and set the Active
Directory password.

WMIconfig.jse —-remote:remotePC —-user:Administrator
-password:<password> ad .password=ADPassword
.enabled=true

Now we need to associate the DASH management device’s Administrator role with
an SID.

WMIconfig.jse —-remote:remotePC -user:Administrator
—-password:<password> adident
"?ElementName='Administrator role AD Identity'" .sid=S-
1-5-21-653784745-370644826-2676878800-512

Activating DASH Functionality

To finally enable the DASH management interface, execute the following command:

WMIconfig.jse —-remote:remotePC -user:Administrator
—-password:<password> oob .enabledstate=2

Using DASH Functions

The power in DASH is in its support from management console vendors. The
technology is of limited use if the management tools you rely on for day-to-day
enterprise management do not understand or take advantage of the capabilities

DASH provides.

HP works closely with management console vendors and partners to ensure an
ecosystem of supporting products is available to help you realize the potential of
DASH in your environment.

The following products have been tested by HP and tested and developed by our
partners using HP business PC hardware:

o HP Client Automation 7.5

e HP Out-of-Band Manager 4.0

e AMD DASH Plug-in for Microsoft Systems Center
e Symantec Real-Time Systems Manager 7.0

e Symantec Out-of-Band Management Console 7.0

11



Symantec Real-Time Systems Manager out-of-band device discovery
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Most consoles integrate DASH functionality into the routine operations you already
perform. Once your management console has discovered the DASH capability of
your computer systems, operations such as scheduled remote patch management
will use DASH technology to remotely boot or wake the systems using DASH,
perform the desired operation and reset the systems to their previous power state.

In addition, DASH provides a higher degree of visibility to the health of your
enterprise computer systems and makes it easier to remotely diagnose and triage

problems when they occur.
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HP Client Automation Standard device management with DASH
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HP Client Management Web View

In addition to managing the DASH-enabled PC through a management console, HP
provides a convenient method to access out-of-band management functions through
a web browser.

The HP Client management Web View is a web browser-based interface for limited
remote system management. The web view is only functional once the
management controller has been provisioned for DASH management and an
Administrator account has been enabled,

The HP Client management Web View is accessible from the following web
browsers:

e Microsoft Internet Explorer 6 SP1 or newer

e Netscape Navigator 7.1 or newer

e Mozilla Firefox 1.0 or newer

e Mozilla 1.7 or newer

Management functions accessible from the web-based user interface include:

e Access to hardware inventory information for system, processors, and memory
o Visibility to system power state and remote power control operations

e Network configuration settings

e Access to platform event and audit logs

e User and role management functions

13



The following steps outline connecting to the out-of-band management service from
the embedded web server included on the Broadcom NetXtreme™ Ethernet Gigabit
Plus controller. This interface provides an alternative control mechanism for utilizing
the DASH functionality without requiring a DASH enabled management console.

These steps assume that both of the following preconditions have been met:

The DASH management functionality has been enabled both in BIOS on the
Broadcom NetXtreme™ Gigabit Ethernet Plus controller.

The user account to connect as has been configured with a password for
authentication.

And the user account has been enabled for use.

Steps to enable and configure DASH in an automatable fashion via Windows®
Management Instrumentation (WMI) are covered in the section Enabling DASH
Support. Additional discussions for configuring options manually are covered in
Appendix B: Enabling Management Functionality with Computer Setup and

Appendix C: Enabling Management Functionality with BMCC and BACS.

1.

Using your web browser of choice from a separate computer system, connect to
the IP address and DASH management port of the remote system.

DASH Management Ports

TCP Port Purpose Example URL

623 WS-Man over HTTP http://172.16.2.17:623
664 WS-Man over HTTPS https://172.16.2.17:664

These are the well-known IANA ports reserved for DASH management traffic.
By default the Broadcom NetXtreme™ Gigabit Ethernet Plus controller will use
these ports for DASH traffic, but the device can be configured to either disallow
HTTP traffic, or use other TCP ports for communication.

The web browser makes a connection to the HP Client management Web View,
but will require authentication to grant access to the web page.

14



Logon screen
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Lser name: Iﬁ | ;I

Password: I

[ Remember my password
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3. Enter the user name and password to use for authentication. If you have not
created any additional accounts, you can connect with either of the predefined
accounts of “Administrator” or “Operator”.

4. Once your access has been authenticated, you will have access to a
management portal similar to the figure below:

Web management portal
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Troubleshooting

The installation of management agent is required to support various DASH
functions, such as gracefully shutting down the system, and is installed on factory
system image. When building a custom image, management agent and CIM
options can be selected during Broadcom Advance Control Suite (BACS)
installation. The following command line can be used to silently install
management agent with BACS similar to factory image. Please note, command
and parameters must be entered on the same line. Refer to SilentMgmtAppsa.ixt in
MgmtApps directory for more information on silent installation.

Setup.exe /s /v" /qgn
ADDSOURCE=BACSi32,BASPi32,CIMi32,MgmiCfgi32,MgmtAgenti32"

Firmware updates are currently released as an image file with factory default
settings. BMCC tool can be used to export current settings into a file that can be
used to import the seftings back after update. A sample batch file is included with
the firmware update as an example to automate settings export, firmware update,
and setting import. This example uses BMCC and firmware upgrade utility for
Windows. Both are included in the firmware softpagq.

DASH functionality requires a communication channel between the hardware
platform features, system BIOS, and the Broadcom NetXtreme™ Gigabit Ethernet
Controller. The introduction of additional PCl Express cards into the platform can
disrupt the communication channels utilized for DASH. This type of disruption can
be manifested as the inability to issue requested power state changes to the DASH
enabled platform for example.

In the event that you experience inconsistencies in DASH behavior, remove PCle
option cards one by one to determine the conflicting device. Once you have
determined the PCle option card that is interfering with DASH functionality, contact
HP or the PCle device manufacturer for firmware updates to correct the issue.

The Broadcom NetXtreme™ Gigabit Ethernet Plus functions very similarly between a
dc7900 and a dc5850. However, there is one important difference regarding
remote wake and Power-On Password behavior.

A remote shutdown into a sleep state, S3 - S5, and subsequent remote wake of the
dc5850 will bypass the Power-On Password as the system resumes from the sleep
state. This is the expected behavior.

In the case of the dc7900, there is a hardware limitation that does not report the
remote wake and wakes the system as a localized wake. Therefore, the BIOS
reaction to the wake event is to process it as a localized wake and not bypass the
Power-On Password.
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Appendix A: Broadcom NetXtreme™ Gigabit
Ethernet Plus Network Controller

The Broadcom NetXtreme™ Gigabit Ethernet Plus is the successor to the Broadcom
NetXtreme™ Gigabit Ethernet network adapter. In addition to the standard network
adapter functionality, the Broadcom NetXtreme™ Gigabit Ethernet Plus also
features DASH support. HP offers the Broadcom NetXtreme™ Gigabit Ethernet Plus
integrated and as a discrete PCI Express option.

The Broadcom NetXtreme™ Gigabit Ethernet Plus network adapter is a Broadcom
BCM5761 10/100/1000 Base-T network controller with integrated transceiver,
advanced security, and platform management capabilities including DASH support.

The discrete adapter is a PCle x1 card designed in accordance to the PCI Express
v1.1 specification.

The card comes with a high profile bracket, but is also compatible with low profile
brackets. A low profile bracket is available for this card.

Broadcom NetXtreme™ Gigabit Plus Network adapter PCl Express card

e Integrated 10/100/1000BASE-T transceivers

e Automatic MDI crossover function

e PCl Express v1.1 host interface with multi-function support

e 10/100/1000BASE-T full /half-duplex MAC

e IPv4 and IPv6 Large Send Offload and Checksum Offload (LSO/TCO)

e Receive Side Scaling (RSS) for multicore client processors
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e Wake-on-LAN (WOL) support meeting the ACPI requirements
e Statistics for SNMP MIB II, Ethernet-like MIB, and Ethernet MIB (802.3z, Clause
30)

o System Management Bus (SMBus) interface supporting Desktop and mobile
Avrchitecture for System Hardware (DASH) v1.1 or Alert Standard Format (ASF)
v2.0

e Centralized Power Management Unit (CPMU)

o Serial NVRAM interface with Flash auto-sensing

e PCle CLKREQ support

e DASH 1.0 and 1.1 support with additional HP value-add management features

The Broadcom NetXtreme™ Gigabit Ethernet Plus discrete PCle option card comes
with a double female-ended 10-pin USB cable. One end of this cable connects to
the male USB header on the Broadcom NetXtreme™ Gigabit Ethernet Plus, and the
other end connects to an identical header on the system board. On newer
platforms the system board connector is labeled for DASH functionality.

PCle Adapter Configuration:

The USB cable is only required to connect the PCle
network adapter option card with the system board and
BIOS. With the introduction of the integrated solution,
available on some systems, the cable is no longer
required.

On some platforms the male USB header on the system board is reserved for two
functions:

e Microsoft Windows® ReadyBoost performance cache

* DASH management protocol

Internal USB Connector

DASH and ReadyBoost are mutually exclusive options.
Because there is only one internal USB connector dual-
purposed for both functions, you will have to choose the
option which fits best within your environment.

Additionally on certain systems there is a secondary internal USB connector.
Although there is a similar male USB header on the system board reserved for the
Media Card Reader, this header is not the same as the one for purposed for DASH
or ReadyBoost. If the USB cable is connected to the Media Card Reader
connection, DASH features will not function properly.

The USB cable serves two purposes and is critical for DASH functionality:
o Communication between the Management Controller and system BIOS

o Data transfer for USB-redirection
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USB-redirection is the mechanism the Broadcom NetXtreme™ Gigabit Ethernet Plus
controller uses to support the USB Redirection Profile. USB-redirection is a DASH
1.1 feature that allows the contents of a remote media source (ISO image) to be
redirected to the remotely managed PC as a USB mass storage device.

Appendix B: Enabling Management Functionality
with Computer Setup

When the Broadcom NetXtreme™ Gigabit Ethernet Plus add-in card is installed into
a system, it will not be the default management controller (except on the dc5850
where the controller will be the default and will only support ASF management
functions). For systems supporting the full management capabilities, the user may
manually set the Broadcom NetXtreme™ Gigabit Ethernet Plus as the primary
management controller in Computer Setup (F10) for the PCl Express network
adapter to perform the role of DASH manageability. Multiple network adapters
can function simultaneously, but only one management controller can be active at a
given time.

Computer Setup Differences

The Computer Setup screens relating fo management
devices and modes differ slightly between various HP
business desktops and workstations.

The primary management controller can be configured through: Computer Setup >
Advanced > Management Devices.

The current management mode (ASF, AMT, or DASH) can be identified via
Computer Setup > File > System Information.

By default, the embedded Broadcom Ethernet controller is primary management
controller. The Broadcom NetXtreme™ Gigabit Ethernet Plus must be changed to
be the primary management controller for DASH to be enabled.
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Management devices in the HP Compaq dc5850 Business PC

Heulett-Packard Setu

Broadcom Ethernet controller
Broadcom Ethernet embedded

LOCAL: <F1=Help> REMOTE: F1=ESC+1, F5=ESC+5, F10=ESC+0

Advanced

Power-On Options
Execute Memory Test
BIOS Power-On
Management Devices

»Primary
Non—boot

F10=Accept, ESC=Cancel
Bus Options
Device Options

Once the Broadcom NetXtreme™ Gigabit Ethernet Plus is made the primary
management controller and the system is rebooted, the Management Mode will

change to DASH.

Management Mode (DASH highlighted) in the HP Compaq dc5850 Business PC

Product Name

SKU Mumber

Processor Type
Processor Speed
Processor Stepping
Cache Size (L1/L2/L3)
Memory Size

Memory controller 0
Memory controller 1
Integrated HAC

System BIOS

Chassis Serial Number
Asset Tracking Number
Management Mode

LOCAL: <F1=Help> REMOTE: F1=ESC+1, F5=ESC+5, F10=ESC+0

System Information

AMD Phenom(tm) 9600 Quad-Core Processor
2300/1800 MHz
00100F22
128KBx4 / S512KBx4 / 204BKBx1
4096 NB DDRZ2/800 MHz
DINMM1 1024 MB / DINN3 1024 NB
DINNZ 1024 MB / DINM4 1024 NB
001D92731EC3
786F6 v02.04
HNDS001370
ECHO is off
DASH
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By default, the embedded Intel Ethernet controller is primary management
controller. The Broadcom NetXtreme™ Gigabit Ethernet Plus must be changed to
be the primary management controller for DASH to be enabled.

Management controller in the HP Compaq dc7900 Business PC

Hewlett-Packard Setup Utilits

Foue Advanced

Pouer—On Options

Execute Memory Test

BIOS Pouer—Om
Hanagement Devices

Intel Ethernet embedded
Broadcom Ethernet controller

Hanagement Devices

Hanagement Operations

: <F1=Help> REMOTE: F1=ESC+1, F5=ESC+5, F10=ESC+0

The HP Compaqg dc7900 Business PC is an Intel Q45-based system which has an
intfegrated management controller (often referred to as the Management Engine or
ME) within the chipset for management control.

The ME firmware version is displayed in the Computer Setup System Information
page right above the management mode. The placement of the ME firmware
version and the management mode is in close proximity, but there is no correlation
between the two lines.
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Management Mode (DASH highlighted) in the HP Compaq dc7900 Business PC

Heulett-Packard Setup Utility

System Information

Product Name

SKU Number

Processor Type Intel (R) Core(IN)2 Duo CPU EB8400 @ 3.00GHz
Processor Speed 3000/1333 MHz

Processor Stepping 00010677 ©00000AO7

Cache Size (L1/L2) 64KBx2 / 6144KBx1

Memory Size 2648 NB DDRZ/866 MHz/Dual Channel
Channel A XMl 1624 NB / X2 e B
Channel B XMN3 1624 NB / X4 6 B
Integrated HAC 00215ASFC41C

System BIDS 78661 v01.68

Chassis Serial NHumber abcd123456

Asset Tracking Humber

HE Firmuware Uersion 5.8.1.1111

Hanagement Mode DASH

OCAL: <Fl=Help> REMOTE: F1=ESC+1, F5=ESC+5, F10=ESC+0

The following chart shows the correlation between the management controller and
management mode for the HP Compagq dc7900.

Correlation between management controller and management modes

Primary Management Controller Management Modes Supported
Intel® Management Engine AMT, ASF, None
Broadcom TruManage™ DASH, ASF

In the case of ASF, both management controllers can be in this mode. However,
only the primary management controller will actually be in control.

Identifying the primary management controller differs slightly on the HP Z800
Workstation. The figure below illustrates the selection of management device
between the multiple Broadcom controllers within the platform.
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Management controller in the HP Z800 Workstation

Hewlett-Packard Setu
[Tl Advanced

Power-On Options
BIOS Pouer—0On

Hanagement Devices

Broadcom Ethernet controller (ASF) Non-boot
Broadcom Ethernet controller PPrimary

F10=fAccept, ESC=Cancel

Slot 1 PCle2 xB(4)
Slot 2 PCIe2 %16
Slot 3 PCle xB(4)
Slot 4 PCle2 x16(8)
Slot 5 PCIe? %16
Slot 6 PCI32

Slot 7 PCle2 x16(8)

Management Devices

Management Operations

Bus:96 Device:0 Function:0 Vendor/Device 1D:14E4/168151ot 7 PCle2 x16(8)

Appendix C: Enabling Management Functionality
with BMCC and BACS

Manageability features such as DASH and ASF are disabled by default on the
Broadcom NetXtreme™ Gigabit Ethernet Plus network adapter. This section
provides information on additional configuration tools available for setting up
DASH functionality on the Broadcom NetXtreme™ Gigabit Ethernet Plus network
adapter. Enabling DASH in this manner is an alternative to the WMI deployment
methods discussed earlier, and still requires that the Broadcom NetXtreme™
Gigabit Ethernet Plus network adapter is set as the primary management device
within the system BIOS in order to function properly.

DASH can be enabled in one of two methods:
e Broadcom Manageability Configuration and Control application (BMCC)
e Broadcom Advanced Control Suite (BACS)

BMCC is not pre-installed in the system image. It requires the Broadcom
NetXtreme™ Gigabit Drivers for Multiple Operating Systems Softpaq to be
downloaded. BACS is included in the system image.

The following steps will enable DASH with BMCC:
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Download the Broadcom NetXtreme™ Gigabit Drivers for Multiple Operating
Systems Softpaq from www.hp.com.

1. Install the Softpagq.

2. Open a Command Prompt as Administrator.

3. Go to the directory where the Broadcom application is installed.

4. Execute the command: bmcc enable.

The following steps will enable DASH with BACS:

1. Execute BACS.

2. Choose the Broadcom NetXtreme™ Gigabit Ethernet Plus network adapter.

Note that all network adapters will be displayed by BACS. The Broadcom
NefXtreme™ Gigabit Ethernet Plus can be identified through the Information tab.
Look for the ASIC and Firmware of 5761.

Broadcom NetXireme™ Gigabit Ethernet Plus network adapter - Information tab

Broadcom Advanced LONLIol Suie
File View Tools Help
Explorer View n

ion | % Diagnostics | I3 Configurations | I Statistics |

Device Management = T
|1 By Type | =% By Connection MAC Address 00-10-18-0E-FF-11
EF g Permanent MAC Address 00-10-18-0E-FF-11
& [T Network Adapters (NDIS driver) L T
i 1PV IP Address e80::09 1 3be2:91b0: 1d37%12
| [0004] Broadcom NetXtreme Gigabit Ethernet Link Status up
Speed (in Mbps) 1000
Offload Capabilties 150,co
Jumbo Miu | 1500
- Driver Information
Driver Status | Loaded
Driver Name | bs7ndsoa. sys
Driver Version 10.100.0.0
Driver Date 6/25/2008
- Resources
Bus Type PCIE (1)
Bus Number 47
Device Number 0
Function Number 0
Memory Address 0XF0300000
| Hardware -
ASIC Version ECMS76180
Firmware Version 5761v3.63
Management Firmware DASH 1.01.0.12

3. Go to the Configuration tab.

4. Expand the OOB Management list to determine if DASH is enabled or
disabled. By default DASH is disabled.

OOB Management list

Broadcom AGvanced CORLIO! ule

File View Tools Help

i ® | T information |4 Diagnostics (2 Configurations /U Statistics |
Device Management =

iE‘ By Type ! i By Connection | Ethemet@iWirespesd Enable (Default)
ol 673 Fiow Control Auto (Default)
. r-':‘ L3 Network Adspters (NDIS chiver) Interrupt Moderation Enable (Default)
2, L Large Send Cffioad (IPv4) Enable (Default)
{75 [oo04] sroadzem Netxreme Gigabit Exhernet Toros ST oAl 2 0] Sreble Default)
-8 Large Send Offioad v2 (IPvG) Enable (Default
Network Address Not Present
Priority & VLAN Priority & VLAN Enabled (Default)
Receive Side Scaling Enable (Default)
Speed & Duplex Auto (Default)
TCP/UDP Chedksum Offioad (IPv4) R & Tx Enabled (Default)
TCP/UDP Checksum Offioad (IPv6) Ry &Tx Enabled (Default)
VLAN ID 0 (Default)

Both (Default)
Lowest Speed Advertised (Default)

DASH 1.0TNnl2
Disabled
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5. Enable DASH and click the Apply button.

Enabling DASH

E L ls  Help
Cxplorervien: ® | T Information | Diegnostics (3 Configurations | T Statistics
Device Management im=
|3 By Type |+ By Connection Ethermetorespesd Enable Default)
EREs Flow Control Autn (Default)
= [ Metwork Adapters (NDIS drver} "“E"‘;" m’“”‘w x ‘D‘:“:”
Large Send Offioad (IPv] = efaul
75 10004 Broadcom Hetxtreme Gigabit Ethermet jg: i DP]vf-) = ;ﬁml:
| e R e A VT S T Large Send Offioad v2 (P6) Enable (Defaul)
Network sddress Mot Present
Prioity 8 LAN Priority & VLAN Enabled (Defaul]
Recelve Side Scaing Enable (Default)
Speed & Duplex Austo Defauit)
TEPLOP Checksum Offioad (1Pv4) R & T Enabled (Defaull)
TCP AP Chedksum Offoad (IPve) Rox & T Enabied (Defaut)
WLAN ID 0 (Defauity
Wake Up Capsbilites Both (Defauit)
WOL Speed Lowest Speed Advertiead (Default)
TrManage Frmware Type Resision 212
gemen Frmmare [=]
=/ T Configuration
Addessing Model Pv4and Pve
oty
7 1pvs
=/ Remate Management (RMCF) 2
Management Firmware
s the ASF or DASH functionaity in the

= Enabl selected network adapler. If there is more than one nebvork adapter in your computer, be sure that you ensble ASF or DASH
3 functionaity in orly one network adspter at & tine,
W) Device Management | e 5y

mrmnw |
= ==

Setting up an Administrator account for DASH requires the use of the Broadcom
NetXtreme™ Gigabit Drivers for Multiple Operating Systems Softpaq. This is
available at www.hp.com.

Execute the Softpaq, and then open a Command Prompt as Administrator.
Use the following steps to create an Administrator account:
1. Go to the directory where the Broadcom application is installed.

2. Execute the command: bmcc edit. This will execute the Broadcom
Manageability Configuration and Control application and will bring up a list of
Management Firmware Configuration options.
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Management Firmware Configuration options

r

B Administrator: Command Prompt - bmec edit l =1CE! l"—'z;"J [

MAC Address: BA1A18AEFEDE IP Address: B.8.0.8
Seryice Mame: {2FCD7756—24DF—4BEB-?A7C-D91B322F3FAA>
Reading configuration records from NHURAM

Exporting 1824 bytes of Opague Management Data...
lerifying configuration records...

Read 181 configuration records (39520 bytes)

Hanagement Firmware Configuration:

IPu4 Settings — Dynamic 192 .168.38.28

IPve Settings — Dynamic feBB::30eb:cBB4:YeB ach3d

User ficcount Management (18>

US—Management — HITP:623 HITPS:664

WS—Event Subscriptions <4

Opagque Management Data <4> 1824 of 1824 bytez available
Console Redirection — Enabled

ASF Alerting (PETs> — szent to . Heartheat @ 608 seconds
ASF Remote Query and Control — RMCP:623 (Ping Only> Secure:664
ASF System Description Tahle

SMBus Interfaces (1D

Advanced Settings

Save to file

Exit

Enter your choice —> _

3. Enter U for User Account Management
4. Enter 2 to access User Accounts
5. Enter 1 to select Administrator Account

Management options

r

BEA Administrator: Command Prompt - bmee edit IEMJ
Enter your choice —> u
ser Account Management:

Return to previous menu [Enterl
User Roles...
User Accounts...

Enter your choice —3> 2
WS—Management Uszer Accounts:

Return to previous menu [Enter]
Account #1 - Administrator
ficcount — Operator

Account
Account
Account
Account
fAccount
Account
fAccount
Account =

Add a User Account
Delete a User Account

=3

Enter your choice —> 1

6. Enter 2 to change the account status from Offline = True to Offline = False.

7. Enter 4=XXXX where XXXX is the new Administrator password. By default, the
password is blank.
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Management options

BN Administrator: Command Prompt - bmcc edit l ol P S
6. Roles : BxPORERER1

Enter wvour choice {item=value) —-> 2

WS —Management User Account #1 Settings:

g RBeturn to previous menu [Enterl

1 Created. .

2 Off line

3 User ID "Administrator"
4 Password...... A

o Organization.. "My Company"'

6 : BxPBOROREE1

Enter your choice (item=valued - 4=Password
LIS—Management User Account #1 SBettings:

Return to previous menu [Enterl
Created... : True
EET
"Administrator"
Password.. "Password"
Organization.. "My Company'’
Roles......... Ax80088001

8. Enter 0 twice to navigate back to the main menu.
9. Enter Q to Save and Exit.

Save and exit

B8 Administrator: Command Prompt - bmec edit l =1L l"—'ﬁ‘—J [
llzer Account Management:

@. Return to previous menw L[Enterl
1. User Roles...
2. User Accounts...

Enter your choice -> B
Hanagement Firmware Configuration {(changed>:

IPu4 Settings — Dynamic 192 .168.38.28

IPvh Settings — Dynamic feBB::30e5:cBB4:YeB:ach3d

User fAccount Management (18>

US—Management — HITPF:623 HITPS:664

WS—Event Subscriptions <4

Opagque Management Data <4)> 1824 of 1824 bytesz available
Console Redirection — Enabled

ASF Alerting (PETs) — sent to . Heartheat @ 68 seconds
ASF Remote Query and Control — RMCP:623 (Ping Only> Secure:664
ASF System Description Tahle

SMBusz Interfaces (1D

Advanced Settings

Save to file

Save to MURAM and Exit

Exit without zaving changes

Enter vour choice —>

After saving to NVRAM and exiting, the Administrator account along with the
password has been created.
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